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SDMC concepts

The IBM Systems Director Management Console (SDMC) is the next generation Hardware Management
Console (HMC) that combines the functions of the HMC, the simplicity of the Integrated Virtualization
Manager (IVM), and the value-add functions of the IBM® Systems Director. The SDMC provides server
management and PowerVM™ virtualization management.

The SDMC is a management console for managing IBM Power Systems™ servers and IBM BladeCenter®

Power blade servers. The SDMC is an alternative and replacement for the current HMC with enhanced
virtualization and hardware management capabilities. The SDMC is an x86-based console. The SDMC
manages IBM AIX®, IBM i, or Linux operating systems on IBM Power Systems servers and IBM
BladeCenter Power blade servers.

© Copyright IBM Corp. 2011 1
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Comparing HMC and SDMC features

You need to understand the differences between the Hardware Management Console (HMC), Integrated
Virtualization Manager (IVM), and IBM Systems Director Management Console (SDMC) environments
including terminology, users and roles, supported features, high availability options, and command-line
differences.

Comparing the HMC and SDMC
There are some important differences between the HMC and the SDMC.

With the SDMC, the scope of administered systems spans from POWER blade servers to high-end
systems, providing a single, consistent approach to systems administration.

The characteristics of both the HMC and the SDMC, at a high level, follow:

HMC

v Is implemented as an external, independent appliance
v Can administer entry-level systems to high-end systems
v Can administer more than one managed system
v Allows for more than one VIOS per managed system

SDMC

v SDMC is offered as an appliance in two forms:
– A hardware appliance similar to the HMC, using essentially the same hardware plus additional

memory and disk.
– A virtual appliance that runs in a VMware partition

v Can administer entry-level systems to high-end systems
v Can administer more than one managed system
v Allows for more than one VIOS per managed system
v Supports entry-level systems to high-end systems plus blades.

How the SDMC is used
SDMC represents the next generation of management appliances for POWER processor-based systems.
The SDMC replaces both the HMC and IVM in POWER processor-based systems administration. Thus,
the SDMC can manage POWER systems directly but can also work with the HMC and IVM side by side
to ease transition.

SDMC is integrated into the administrative framework of IBM Systems Director. It provides a common
interface for systems administration across the data center. If you have used an HMC or IVM, you will
already be familiar with SDMC tasks and procedures. The Systems Director provides additional tasks that
you might want to explore. Note that these additional Systems Director tasks and navigation options
might make it more difficult to find familiar HMC tasks. For more information about navigating the
SDMC GUI, see “Navigation differences between the HMC GUI and the SDMC GUI” on page 7.

The SDMC can unify platform management for IBM Systems, providing a consistent interface for
common management tasks. By integrating POWER processor-based systems management into the IBM
Systems Director framework, you can easily manage many systems of different types. The SDMC also
enables the integration of POWER processor-based systems into data center management tools.

© Copyright IBM Corp. 2011 3



As a successor to both the HMC and IVM, the SDMC administrators can work with a high-level view of
systems. It organizes tasks in a single window, instead of using different menus. This interface simplifies
views on systems and provides faster access to day-to-day tasks.

As it was with older POWER processor-based systems, the transition to the SDMC requires that
management for POWER5 and POWER5+ processor based systems continue with either the HMC or
IVM. The SDMC can administer the HMC and IVM as well; however, this management console eases
transition from older environments into new ones.

Virtualization enhancements
SDMC has made managing your virtualization environment significantly easier, while maintaining all of
the HMC's existing functions.

The enhancements follow:

Virtual I/O management
In addition to the HMC's Virtual Storage Management view, The SDMC brings similar
simplification to the Create Virtual Server and Manage Virtual Server views. With SDMC, you can
see the storage devices attached to a virtual server and need not be concerned about your virtual
SCSI device pairs and the VIOS command-line.

Simplified Create Virtual Server wizard
Create Virtual Server (known as logical partition on the HMC) wizard asks only what is needed
to create the virtual server, and selects reasonable defaults for all other settings. Advanced users
who want full control can change the profile after the wizard is completed to control all of their
settings, such as min/max values. You can now create a virtual server by simply specifying the
name and clicking Finish.

Managing virtual server
A task called Manage Virtual Server displays virtual server properties and I/O device
configuration information in one window. With this task, you control the resource assignments
for a virtual server directly (whether the virtual server is powered on or off) without using a
profile.

Terminology differences between HMC and SDMC
The HMC and SDMC environments use different terminology.

For integration into IBM Systems Director, SDMC introduces some synonyms that replace familiar HMC
terms. The key ones to remember are the following:
v Virtual Server (formerly Partition)
v Host (formerly Managed System or Server)
v Power Unit (formerly Frame)

For detailed information about the terminology differences between the HMC and the SDMC, see the
following tables.

Table 1. Networking terms

HMC SDMC Description

Open network Standard network The standard network can be
connected to a firewall or router for
connecting to the Internet.

4 Power Systems: Overview of SDMC



Table 2. Objects

HMC SDMC Description

Hardware Management Console
(HMC), Integrated Virtualization
Manager (IVM)

Platform manager A platform manager manages one or
more hosts and their associated
virtual servers and operating
systems. For Power Systems servers,
the platform managers are HMC and
IVM.

Frame, bulk power assembly (BPA) Power unit The power assembly for processor,
memory, FSP, and I/O enclosures.

Server, managed system, system,
flexible service processor (FSP),
central electronics complex (CEC)

Host A physical server that contains
physical processors, memory, and
I/O resources. The physical server is
often virtualized into virtual servers,
also known as logical partitions.

Logical partition (LPAR), dynamic
LPAR (DLPAR), partition

Virtual server The collection of processor, memory
and I/O resources defined to run an
operating system and its applications.

Virtual I/O Server (VIOS) Utility virtual server A virtual server that provides
virtualization capabilities for a
particular environment.

CEC, Frame, and LPAR states Director states

Table 3. Tasks

HMC SDMC Description

Remove connection – systems Remove host The remove tasks removes the host
from the directory database.

Table 4. Users and roles

HMC SDMC Description

hscroot sysadmin Predefined administrator user for the
platform manager.

hscpe pe Predefined service and support user
for the platform manager.

hmcsuperadmin SMAdministrator (Administrator
role)

The Administrator role has full
authority to all resources and tasks,
including security administration,
product installation, and
configuration.

hmcoperator SMManager (Manager role) The Manager role can perform a
subset of the tasks that an
administrator can perform. Typically,
system administration, system health
management, and configuration tasks
are available.

N/A SMUser (User role) The User role includes any
authenticated user and allows only
basic operations such as viewing
resources and properties.
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Table 4. Users and roles (continued)

HMC SDMC Description

hmcviewer SmMonitor (Monitor role) The Monitor role can access those
administrative functions that provide
read-only access. Primarily,
monitoring, notifications, and status
tasks are available.

hmcservicerep SMServiceRep (PE role) The PE role includes the pe user and
gives users the ability to perform
only service operations, such as
viewing resources, logs, and system
status and health.

Table 5. Hosts and system states.
Note: SDMC states include operating states, detailed states, and health states.

HMC states SDMC operating states SDMC detailed states SDMC health states

Operating Started N/A OK

Standby Standby N/A OK

Power off Stopped N/A OK

Service processor failover Started Service processor failover Degraded/warning

Power off in progress Stopping N/A OK

Initializing Starting N/A OK

No connection * (should be
handled by Access Point
state)

Not available Unknown Unknown

Pending authentication Waiting for input Password updates required Degraded/warning

Failed Authentication *
(Should be handled by
Access Point state, that is,
Failed Access)

Not available Unknown Unknown

Error Error Unknown Critical failure

Error - terminated Error Terminated Critical failure

Error - dump in progress Error Dump in progress Critical failure

Recovery Error Recovery Critical failure

Incomplete Error Incomplete Critical failure

Version mismatch Error Version mismatch Major failure

Table 6. Virtual server and partition states

HMC states SDMC operating states SDMC detailed states SDMC health states

Running Started N/A OK

Starting Starting N/A

Not activated Stopped N/A Unknown

Migrating - not activated Relocating N/A OK

Migrating - running Relocating N/A OK

Shutting down Stopping N/A OK

Open firmware Waiting for input Open firmware OK
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Table 6. Virtual server and partition states (continued)

HMC states SDMC operating states SDMC detailed states SDMC health states

Hardware discovery Started Performing hardware
discovery

OK

Error Error Unknown Major failure

Not available Not available Unknown Unknown

Table 7. Power unit states

HMC state SDMC Operating State SDMC Detailed State SDMC Health State

Standby Standby N/A Degraded

Standby/starting Standby N/A OK

Starting Starting N/A

Pending frame number
change

Standby N/A Degraded

Failed authentication Not Available Unknown Unknown

Pending authentication Waiting for input Password updates required Degraded / Warning

No connection Not available Unknown Unknown

Incomplete Error Incomplete Critical failure

Version mismatch Error Version mismatch Major failure

Navigation differences between the HMC GUI and the SDMC GUI
This section describes the differences in navigating to commonly used Hardware Management Console
(HMC) tasks on the HMC and on the Systems Director Management Console (SDMC).

Because IBM Systems Director manages many different types of objects, it has a generic navigation style.
Systems Director groups managed objects and shows general properties for each object. The SDMC
interface is quite similar to the HMC interface.

Below is a list of commonly-used HMC tasks, and where they can now be found in the SDMC interface:

Viewing host (server) properties by using the SDMC interface

The Properties task in SDMC is different from that of the HMC. The SDMC now calls a server a host.

To view server properties by using the HMC, complete the following steps:
1. In the navigation pane, selectSystems Management.
2. Select the server.
3. In the contents pane, select Tasks > Properties.

To view host properties by using the SDMC, complete the following steps
1. From the Resources page, right-click the host.
2. Select System Configuration > Edit Host.

Viewing virtual server (partition) properties by using the SDMC interface

To view partition properties by using the HMC, complete the following steps:
1. In the navigation pane, selectSystems Management.

Comparing HMC and SDMC features 7



2. In the contents pane, expand the server.
3. Select the logical partition.
4. Click Tasks > Properties.

The SDMC now calls a partition a virtual server.

To view virtual server properties using the SDMC, complete the following steps:
1. From the Resources page, select the virtual server.
2. Click System Configuration > Manage Virtual Server.

Discovering a system to manage using the SDMC interface

Discovery is a general Systems Director concept of finding a system or object to manage. You can use the
SDMC interface to discover and manage the following objects:
v Host flexible service processors (FSPs) and host power units
v Bulk power controllers (BPCs) and frames
v Operating systems

If you are using the SDMC as a Dynamic Host Configuration Protocol (DHCP) server for your managed
systems, the FSPs and BPCs are discovered automatically. If you are not using the SDMC as a DHCP
server, you can discover the resource by entering a host name, an IP address, or a range of IP addresses
in the Discover section of the GUI or the command-line interface (CLI).

To discover a system to manage by using the HMC, complete the following steps:
1. In the navigation pane, selectSystems Management.
2. Select the server.

To discover a host to manage by using the SDMC, complete the following steps:
1. On the Resources page, clickCommon Tasks > System Discovery.
2. Select a discovery option, IP address, and the resource type to discover.
3. Click Discover now.

Powering a server (host) on or off by using the SDMC interface

To power a server on or off by using the HMC, complete the following steps:
1. In the navigation pane, selectSystems Management.
2. Select the server.
3. In the contents pane, select Tasks > Operations > Power On or Tasks > Operations > Power Off.

The SDMC now calls a server a host.

To power a host on or off by using the SDMC, complete the following steps:
1. From the Resources page, right-click the host.
2. Select Operations > Power on or Operations > Power off.

Creating a logical partition (virtual server) by using the SDMC interface

To create a logical partition by using the HMC, complete the following steps:
1. In the navigation pane, selectSystems Management.
2. Select the server on which you want to create a logical partition.
3. In the contents pane, select Tasks > Configuration > Create logical partition.
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The SDMC calls a partition a virtual server. To create a virtual server by using the SDMC, compete the
following steps:
1. From the Resources page, right-click the host.
2. Select Create Virtual Server.

Comparing HMC tasks and SDMC tasks
This section provides detailed task information for moving from Hardware Management Console (HMC)
to Systems Director Management Console (SDMC) for each HMC task.

Server (host) tasks
This topic provides server task information for moving from HMC to SDMC. Servers are known as hosts
on the SDMC.

The following task mapping information is available in this topic:
v Server (host) properties task mapping
v Server (host) operations task mapping
v Server (host configuration task mapping
v Server (host) connections task mapping
v Server (host) hardware information task mapping
v Server (host) updates task mapping
v Server (host) serviceability task mapping
v Server (host) Capacity on Demand task mapping

Table 8. Server (host) properties task mapping

HMC task SDMC task Is the task identical? Notes

View Properties System Configuration >
Edit Host

Yes The properties task on
SDMC is different from that
on the HMC.

For more information about
performing this task, see
Changing host properties.

Table 9. Server (host) operations task mapping

HMC task SDMC task Is the task identical? Notes

Power On and Power Off Operations > Power On /
Power Off

No The function is the same,
but the interface is
different.

For more information about
performing this task, see
Powering on the host.

Power Management Operations > Power
Management

No The function is the same,
but the interface is
different.

For more information about
performing this task, see
Performing POWER
management operations.
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Table 9. Server (host) operations task mapping (continued)

HMC task SDMC task Is the task identical? Notes

LED Status > Deactivate
Attention LED

Service and Support >
Hardware > System
Attention LED

Yes For more information about
performing this task, see
Activating and deactivating
the Attention LED.

LED Status > Identify LED Service and Support >
Hardware > Identify LED

Yes For more information about
performing this task, see
Locating parts with the
Identify LED.

LED Status > Test LED Service and Support >
Hardware > LED Lamp
Test

Yes For more information about
performing this task, see
Performing an LED lamp
test.

Schedule Operations Operations > Schedule
Operations

No The function is the same,
but the interface is
different.

For more information about
performing this task, see
Scheduling host operations.

Launch Advanced System
Management (ASM)

Operations > Launch
Advanced System
Management (ASM)

No The function is the same,
but the interface is
different.

For more information about
performing this task, see
Launching Advanced
System Management.

Utilization Data > Change
Sampling Rate

Operations > Utilization
Data > Change Sampling
Rate

Yes For more information about
performing this task, see
Changing the sampling rate
for utilization data.

Utilization Data > View Operations > Utilization
Data > View Utilization
Data

Yes For more information about
performing this task, see
Viewing host utilization
data.

Rebuild Operations > Rebuild
Managed System

No The function is the same,
but the interface is
different.

For more information about
performing this task, see
Rebuilding a managed
system.

Change Password Operations > Change
Password

No The function is the same,
but the interface is
different.

For more information about
performing this task, see
Changing host passwords
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Table 10. Server (host) configuration task mapping

HMC task SDMC task Is the task identical? Notes

Create Logical Partition System Configuration >
Create Virtual Server

No The HMC has 3 separate
tasks. The SDMC combines
these tasks into one task.

For more information about
performing this task, see
Creating virtual servers.

System Plans >
Create/Deploy

System Configuration >
Manage System Plans

Mostly The SDMC task places all
system plan function under
the Manage System Plans
task.

For more information about
performing this task, see
Creating a system plan by
using the SDMC.

View Workload
Management Groups

System Configuration >
View Workload
Management Groups

Yes

Manage Profile Data >
Restore/Initialize/Backup/
Delete

System Configuration >
Manage Virtual Server Data
> Restore/Initialize/
Backup/Delete

Yes For more information about
performing this task, see
Managing profiles for
virtual servers.

Manage System Profiles System Configuration >
Manage System Profiles

Yes For more information about
performing this task, see
Managing system profiles.

Virtual Resources > Virtual
Storage Management

System Configuration >
Virtual Resources > Virtual
Storage Management

Virtual Resources > Virtual
Network Management

System Configuration >
Virtual Resources > Virtual
Network Management

Yes

Table 11. Server (host) connections task mapping

HMC task SDMC task Is the task identical? Notes

Service Processor Status System Configuration >
Edit Host

Yes

Reset or Remove
Connection

Security > Revoke Access,
Security > Request Access,
Remove

Revoke access removes the
connection. Request access
reestablishes it. The remove
operation is the equivalent
to Remove Connection.

For more information about
performing this task, see
Revoking connection access.

Disconnect Another
Management Console

Service and Support >
Reset Other Management
Console Connection
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Table 11. Server (host) connections task mapping (continued)

HMC task SDMC task Is the task identical? Notes

v Add Managed System

v Update Password

v Common Tasks > System
Discovery

v Security > Request
Access

Adding a system is a
two-step process on SDMC.
First, discover the system,
and then request access. On
the HMC it can be done in
one step.

For more information about
performing this task, see
Adding hosts to the SDMC.

Table 12. Server (host) hardware information task mapping

HMC task SDMC task Is the task identical? Notes

Adapters > Host Ethernet Hardware Information >
Adapter > Host Ethernet

Yes

Adapters > Host Channel Hardware Information >
Adapter > Host Channel

Yes

View Hardware Topology Hardware Information >
View Hardware Topology

Yes

Table 13. Server (host) updates task mapping

HMC task SDMC task Is the task identical? Notes

Change Licensed Internal
Code

Release Management > See
notes

No The HMC uses a wizard for
updates, whereas the
SDMC has separate steps
for updates. Update tasks
are under the Release
Management menu.

For more information about
performing this task, see
Updating the host.

Upgrade Licensed Internal
Code

Release Management > See
notes

No Upgrade, change, and
update operations have the
same user flow on SDMC.

For more information about
performing this task, see
Updating the host.

Check System Readiness Release Management >
Readiness Check

No

View System Information Release Management >
Power Firmware
Management

No In SDMC, power-specific
update tasks are under the
Power Firmware
Management task.

For more information about
performing this task, see
Managing Power system
firmware.
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Table 14. Server (host) serviceability task mapping

HMC task SDMC task Is the task identical? Notes

Manage Serviceable Events Properties > Active Status >
Category: Service Status

No
For more information about
performing this task, see
Managing serviceable
problems by using Service
and Support Manager.

Create Serviceable Event Service and Support >
Submit Service Request

No For more information about
performing this task, see
Submitting service request
using Service and Support
Manager.

Reference Code History Service and Support >
Reference Code History

Yes For more information about
performing this task, see
Reference Code History.

Control Panel Functions >
(20) Type, Model, Feature

Service and Support >
Control Panel Functions >
(20) Type, Model, Feature

Yes For more information about
performing this task, see
Control Panel Functions.

Hardware > Prepare For
Hot Repair/Upgrade

Service and Support >
Hardware > Prepare For
Hot Repair/Upgrade

Yes For more information about
performing this task, see
Preparing for Hot Repair or
Upgrade.

Hardware > Exchange FRU Service and Support >
Hardware > Exchange FRU

Yes For more information about
performing this task, see
Exchange FRU.

Hardware > Power On/Off
Unit

Service and Support >
Hardware > Power On/Off
Unit

Yes For more information about
performing this task, see
Power On/Off Unit.

Hardware > MES Tasks Service and Support >
Hardware > MES Tasks

Yes For more information about
performing this task, see
MES tasks.

Manage Dumps Service and Support >
Support Files

No For more information about
performing this task, see
Managing support files by
using Service and Support
Manager.

Manage Dumps > System
Dump Parameters

Service and Support >
Dump Settings

No For more information about
performing this task, see
Managing support files by
using Service and Support
Manager.

Collect VPD Inventory > View and
Collect Inventory

No

FSP Failover >
Setup/Initiate

Service and Support > FSP
Failover > Failover
Initiate/Failover Setup

Yes For more information about
performing this task, see
FSP Failover.
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Table 15. Server (host) Capacity on Demand task mapping

HMC task SDMC task Is the task identical? Notes

All Tasks System Configuration >
Capacity on Demand (CoD)

No SDMC has combined all
CoD functions into one
Manage task.

For more information about
performing this task, see
Capacity on Demand for
SDMC.

Partition (virtual server) tasks
This topic provides partition task information for moving from HMC to SDMC. Partitions are known as
virtual servers on the SDMC..

The following task mapping information is available in this topic:
v Partition (virtual server) task mapping
v Partition (virtual server) operations task mapping
v Partition (virtual server) configuration task mapping
v Partition (virtual server) hardware configuration task mapping
v Partition (virtual server) Dynamic Logical Partitioning (DLPAR) task mapping
v Partition (virtual server) console window task mapping
v Partition (virtual server) serviceability task mapping

Table 16. Partition (virtual server) task mapping

HMC task SDMC task Is the task identical? Notes

Properties System Configuration >
Manage Virtual Server

No SDMC has combined
Properties and dynamic
logical partitioning
(DLPAR) tasks into the
Manage Virtual Server task.

For more information about
performing this task, see
Manage virtual server
operations.

Change Default Profile N/A SDMC has removed this
task.

Table 17. Partition (virtual server) operations task mapping

HMC task SDMC task Is the task identical? Notes

Activate > Profile Operations > Activate >
Profile

Yes For more information about
performing this task, see
Activating a virtual server
based on its current
configuration.

Activate > Current
Configuration

Operations > Activate >
Current Configuration

Yes For more information about
performing this task, see
Activating a virtual server.
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Table 17. Partition (virtual server) operations task mapping (continued)

HMC task SDMC task Is the task identical? Notes

Restart Operations > Restart Yes For more information about
performing this task, see
Shutting down and
restarting virtual servers.

Shutdown Operations > Shutdown Yes For more information about
performing this task, see
Shutting down and
restarting virtual servers.

Deactivate Attention LED Service and Support >
Hardware > System
Attention LED

Yes

Schedule Operations Operations > Schedule
Operations

No This task in SDMC is done
on the server (host), not the
partition (virtual server)

Delete Operations > Delete Yes For more information about
performing this task, see
Deleting a virtual server
profile.

Mobility > Migrate Operations > Mobility >
Migrate

Yes For more information about
performing this task, see
Moving the virtual server
with SDMC.

Mobility > Validate Operations > Mobility >
Validate

Yes For more information about
performing this task, see
Validating the configuration
for virtual server mobility.

Mobility > Recover Operations > Mobility >
Recover

Yes

Suspend Operations >
Recover

Operations > Suspend
Operations > Recover

Yes For more information about
performing this task, see
Recovering a suspended
virtual server.

Suspend Operations >
Suspend

Operations > Suspend
Operations > Suspend

Yes For more information about
performing this task, see
Suspending a virtual server.

Table 18. Partition (virtual server) configuration task mapping

HMC task SDMC task Is the task identical? Notes

Manage Profiles System Configuration >
Manage Profiles

Yes The Create Profile wizard
has been removed and is
replaced with the Copy
Profile which launches into
the edit profile function for
changing the profile.

For more information about
performing this task, see
Managing profiles for
virtual servers.

Manage Custom Groups Add To > Existing Group /
Create Group System

No For more information about
performing this task, see
Managing users.
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Table 18. Partition (virtual server) configuration task mapping (continued)

HMC task SDMC task Is the task identical? Notes

Save Current Configuration Configuration > Save
Current Configuration

Yes For more information about
performing this task, see
Saving the current
configuration of a virtual
server.

Table 19. Partition (virtual server) hardware configuration task mapping

HMC task SDMC task Is the task identical? Notes

All Tasks System Configuration >
Manage Virtual Server

No For SDMC, I/O adapter
management is done under
the Manage Virtual Server
task.

For more information about
performing this task, see
Manage virtual server
operations.

Table 20. Partition (virtual server) dynamic logical partitioning (DLPAR) task mapping

HMC task SDMC task Is the task identical? Notes

All Tasks System Configuration >
Manage Virtual Server

No For SDMC, DLPAR tasks
are done under the Manage
Virtual Server task. Note
that DLPAR Move tasks
from the GUI are a
two-step process (remove
and add).

For more information about
performing this task, see
Managing virtual servers.

Table 21. Partition (virtual server) console window task mapping

HMC task SDMC task Is the task identical? Notes

Open Terminal Window Operations > Console
Window > Open Terminal
Console

No The TTY terminal applet
requires you to authenticate
to SDMC.

Close Terminal Connection Operations > Console
Window > Close Terminal
Console

No

Open Dedicated 5250
Console (Local Only)

Operations > Console
Window > Open Dedicated
5250 Console (Local Only)

Yes Launches x-Windows IBM
5250 emulator to the virtual
server in dedicated mode.

Open Shared 5250 Console
(Local Only)

Operations > Console
Window > Open Shared
5250 Console (Local Only)

Yes Launches x-Windows IBM
5250 emulator to the virtual
server in shared mode.
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Table 22. Partition (virtual server) serviceability task mapping

HMC task SDMC task Is the task identical? Notes

Manage Serviceable Events Properties > Active Status >
Category: Service Status

No For more information about
performing this task, see
Managing serviceable
problems by using Service
and Support Manager.

Reference Code History Service and Support >
Reference Code History

Yes For more information about
performing this task, see
Reference Code History.

Control Panel Functions Service and Support >
Control Panel Functions

No For SDMC, all functions are
available in one task.

For more information about
performing this task, see
Control Panel Functions.

Frame (power unit) tasks
This topic provides frame task information for moving from HMC to SDMC. Frames are known as power
units on the SDMC.

The following task mapping information is available in this topic:
v Frame properties task mapping
v Frame connections task mapping
v Frame serviceability task mapping
v Frame operations task mapping

Table 23. Frame properties task mapping

HMC Task SDMC Task Is the task identical? Notes

Frame Properties Edit Power Unit No For more information about
performing this task, see
Changing power unit
properties.

Table 24. Frame connections task mapping

HMC Task SDMC Task Is the task identical? Notes

Bulk Power Assembly
(BPA)

Connections > Bulk Power
Assembly (BPA) Status

No For more information about
performing this task, see
Viewing the bulk power
assembly status.

Status Reset Security > Revoke Access,
Security > Request Access,
Revoke

No Revoke access removes the
connection. Request access
re-establishes it.

For more information about
performing this task, see
Requesting connection
access and Revoking
connection access.
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Table 25. Frame serviceability task mapping

HMC Task SDMC Task Is the task identical? Notes

Manage Serviceable Events Properties > Active Status >
Category:

No For more information about
performing this task, see
Managing serviceable
problems by using Service
and Support Manager.

Hardware > Exchange FRU Service Status Service and
Support > Hardware >
Exchange FRU

Yes For more information about
performing this task, see
Replace FRU.

Hardware > MES Tasks Service and Support >
Hardware > MES Tasks

Yes For more information about
performing this task, see
Performing MES tasks.

Table 26. Frame operations task mapping

HMC Task SDMC Task Is the task identical? Notes

Initialize Operations > Initialize
Power Unit

No For more information about
performing this task, see
Initializing the power unit.

Launch Advanced System
Management (ASM)

Operations > Launch
Advanced System
Management (ASM)

No For more information about
performing this task, see
Launching Advanced
System Manager.

Change Password Operations > Change
Password

No For more information about
performing this task, see
Changing power unit
passwords.

Rebuild Operations > Rebuild No For more information about
performing this task, see
Rebuilding the power unit.

View VLAN Network Data Service and Support > View
VLAN Network Data

Yes For more information about
performing this task, see
Viewing VLAN network
data.

HMC and SDMC management tasks
This topic provides console or appliance task information for moving from HMC to SDMC.

The following task mapping information is available in this topic:
v Update the HMC (SDMC) task mapping
v HMC (SDMC) management: operations task mapping
v HMC (SDMC) management: administration task mapping
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Table 27. Update the HMC (SDMC) task mapping

HMC task SDMC task Is the task identical? Notes

Update HMC Welcome > Settings >
Update SDMC

No If you do not have a
connection to the Internet,
click Stop, and manually
import the updates from a
local file system or from a
File Transfer Protocol (FTP)
server.

For more information about
performing this task, see
Updating the SDMC.

Table 28. HMC (SDMC) management: Operations task mapping

HMC task SDMC task Is the task identical? Notes

View HMC Events System Status and Health >
Event Log Welcome

No

Shut Down or Restart System Status and Health >
Event Log Welcome >
Settings > Restart SDMC

No The Restart task has an
option to simply shut down
as well.

For more information about
performing this task, see
Restarting the IBM Systems
Director Management
Console.

View Trace Logs (HSCPE
Only)

Welcome > Settings >
Serviceability Tasks > View
Trace Logs (PE Only)

Yes

Schedule Operations Task Management > Active
and Scheduled Jobs

No

Format Media N/A No There is no equivalent
function in the SDMC

Back Up HMC Data CLI: backup(hardware
appliance only)

No The SDMC only has a CLI
for backup. This task is
available only on the
hardware appliance. The
virtual appliance can be
backed up with hypervisor
disk snapshots.

For more information about
performing this task, see
Backing up and restoring
the SDMC and Using the
SDMC remote command
line.
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Table 28. HMC (SDMC) management: Operations task mapping (continued)

HMC task SDMC task Is the task identical? Notes

Restore HMC Data CLI: restore(Hardware
Appliance Only)

No SDMC only has a CLI for
restore. This task available
only on the hardware
appliance. The virtual
appliance can be restored
from hypervisor disk
snapshots.

For more information about
performing this task, see
Backing up and restoring
the SDMC and Using the
SDMC remote command
line.

Save Upgrade Data N/A No SDMC upgrades do not
need a separate save
upgrade step.

Change Network Settings Welcome > Settings >
Configuration Tasks >
Configure Network

No For more information about
performing this task, see
Configuring the network.

Test Network Connectivity N/A No There is no equivalent UI
function in SDMC. For ping
and routing information,
the user can the
appropriate command.

For more information about
performing this task, see
Using the SDMC remote
command line.

View Network Topology N/A No There is no equivalent
function in SDMC.

Tip of the Day N/A No There is no equivalent
function in SDMC.

Change Default User
Interface Setting

N/A No There is no equivalent
function in SDMC.

Change Date and Time Welcome > Settings >
Configuration Tasks >
Configure Date/Time

No For more information about
performing this task, see
Configuring date and time.

Launch Guided Setup
Wizard

N/A No The setup wizard is only
shown on initial
configuration.

Table 29. HMC (SDMC) management: Administration task mapping

HMC task SDMC task Is the task identical? Notes

Change User Password Welcome > Settings >
Change user account
password

No For more information about
performing this task, see
Changing user accounts
and passwords.
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Table 29. HMC (SDMC) management: Administration task mapping (continued)

HMC task SDMC task Is the task identical? Notes

Manage User Profiles and
Access

Welcome > Settings >
Create user accounts

Welcome > Settings > View
user accounts

Security > Users

No For more information about
performing this task, see
Managing users and
passwords.

Manage Tasks and
Resource Roles

Security > Roles No For more information about
performing this task, see
Managing users and
passwords.

Manage Users and Tasks Security > Users No In SDMC, you can view
running tasks in the Task
Management area of the
GUI.

For more information about
performing this task, see
Managing users and
passwords.

Manage Certificates CLI: mkcert and updcert No CLI only.

For more information about
performing this task, see
Using the SDMC remote
command line.

Configure KDC Welcome > Settings >
Security Tasks > Configure
Kerberos Client

No For more information about
performing this task, see
Configuring the SDMC as a
Kerberos client.

Configure LDAP Welcome > Settings >
Security Tasks > Configure
LDAP Client

No For more information about
performing this task, see
Configuring the SDMC as
an LDAP client.

Remote Command
Execution

N/A No SDMC enables Secure Shell
(SSH) by default. You can
control this only by using
the firewall.

For more information about
performing this task, see
Using the SDMC remote
command line.

Remote Virtual Terminal N/A No SDMC has removed the
remote VTTY port, and
requires SSH instead for
remote console connections.
The SDMC GUI vterm
applet now uses SSH.
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Table 29. HMC (SDMC) management: Administration task mapping (continued)

HMC task SDMC task Is the task identical? Notes

Remote Operation N/A No SDMC enables remote
access to the web interface
by default. You can control
this only by using the
firewall.

For more information about
performing this task, see
Configuring the network.

Change Language and
Locale

CLI: chconfig –l No The SDMC GUI can be
controlled with the web
browser locale settings. The
console can be controlled
with only the CLI.

For more information about
performing this task, see
Using the SDMC remote
command line.

Create Welcome Text N/A No There is no equivalent
function in SDMC.

For more information about
performing this task, see
Create welcome text.

Manage Data Replication N/A No There is no equivalent
function in SDMC.

Manage Install Resources N/A No There is no equivalent
function in SDMC.

Service management
This topic provides service management task information for moving from HMC to SDMC.

The following task mapping information is available in this topic:
v Service management task mapping
v Service management: connectivity task mapping

Table 30. Service management task mapping

HMC task SDMC task Is the task identical? Notes

Create Serviceable Event Welcome > Manage >
Service and Support
Manager > Open a service
request

No For more information about
performing this task, see
Submitting service request
using Service and Support
Manager.

Manage Serviceable Events Welcome > Manage >
Service and Support
Manager > Serviceable
Problems

No For more information about
performing this task, see
Managing serviceable
problems by using Service
and Support Manager.

Manage Remote
Connections

N/A No There is no equivalent
function in SDMC.
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Table 30. Service management task mapping (continued)

HMC task SDMC task Is the task identical? Notes

Manage Remote Support
Requests

N/A No There is no equivalent
function in SDMC.

Format Media N/A No There is no equivalent
function in SDMC.

Manage Dumps Welcome > Manage >
Service and Support
Manager > Manage
Support Files

No For more information about
performing this task, see
Managing support files by
using Service and Support
Manager.

Table 31. Service management: connectivity task mapping

HMC task SDMC task Is the task identical? Notes

Transmit Service
Information

Welcome > Manage >
Service and Support
Manager > Settings

No For more information about
performing this task, see
Activating the service and
support manager.

Enable Electronic Service
Agent

Welcome > Manage >
Service and Support
Manager > Settings

No For more information about
performing this task, see
Activating the service and
support manager.

Manage Outbound
Connectivity

Welcome > Manage >
Service and Support
Manager > Settings

No For more information about
performing this task, see
Activating the service and
support manager.

Manage Inbound
Connectivity

Welcome > Settings >
Configure VPN

No

Manage Customer
Information

Welcome > Manage >
Service and Support
Manager > Manage your
system contacts

No For more information about
performing this task, see
Managing serviceable
problems by using Service
and Support Manager.

Authorize User Welcome > Manage >
Service and Support
Manager > Settings

No For more information about
performing this task, see
Authorizing user.

Manage Serviceable Event
Notification

Welcome > Manage >
Service and Support
Manager > Settings (click
the learn more about
automation plans link)

No SDMC supports email
notification only. SNMP
trap notification is not
supported.

Manage Connection
Monitoring

N/A There is no equivalent
function in SDMC.

Manage POWER4 Service N/A There is no equivalent
function in SDMC.

Agent Electronic Service
Agent Setup Wizard

Welcome > Settings >
Serviceability Tasks >
Service and Support
Manager Getting Started
Wizard
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Functional differences between the HMC, IVM, and SDMC
There are functional differences between the Hardware Management Console (HMC) and Integrated
Virtualization Manager environments and the Systems Director Management Console (SDMC)
environment.

The SDMC incorporates most functions of the HMC. This has been done through direct mapping of
commands or by replacing functions that are present already in IBM Systems Director. Some functions are
not currently available for the SDMC, such the ability to handle system plans. For a complete listing of
functions, see Comparing HMC tasks and SDMC tasks

Although the SDMC retains most of the functions that are available in the HMC, a few functional
differences exist between the SDMC and the HMC. These differences are directed toward adapting to the
IBM Systems Director environment and also toward improving the user interface.

The command-line interface (CLI) is essentially the same. On the SDMC, most of the commands are just
preceded by smcli. This might require changes to existing scripts that use the HMC.

Enhanced virtualization management

The following are some of the key enhancements in virtualization management that are available in the
SDMC:
v SDMC offers a simplistic IVM kind of user interface for virtualization functions, such as creating a

virtual server.
v The views of virtual server properties and dynamic logical partitioning (DLPAR) are combined to

present a single view from where you can perform all virtual server operations.
v SDMC provides the ability to change the resource assignment of your virtual servers even when they

are in the Stopped state.
v SDMC can manage virtual slots automatically.

Users and roles

The concepts of users and roles in the SDMC remain the same as in the HMC. The user interfaces for
creating and managing users and roles are different in the SDMC. SDMC follows the IBM Systems
Director way of creating and managing users and roles. SDMC supports the use of LDAP and Kerberos
servers. You can create users who use Lightweight Directory Access Protocol (LDAP) or Kerberos for
authentication. Resource roles in HMC are referred to as groupsin SDMC. Also, the session time-out and
the idle time-out settings are global and not configured per user.

For more information about user and roles in the SDMC environment, see Predefined user IDs and
passwords and SDMC roles

User interface enhancements

SDMC provides a user interface that is integrated with the broader IBM Systems Director user interface.
Most of the tasks in SDMC have the same flow as in the HMC with slight enhancements to present an
IBM Systems Director appearance.

Redundancy model

The existing redundancy model available in HMC is available in the SDMC as well. You can connect two
SDMCs to a managed system in which one of the SDMCs acts as the redundant SDMC. You can also use
an HMC for redundant management. Apart from this redundancy model, IBM Systems Director provides
an active-passive availability model that is optional for the SDMC users. In this model, two SDMC nodes
can manage a single server, of which one node is used (active) and the other is not used (passive),
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waiting for a failover condition. The existing HMC active-active redundancy model is available in
addition to the active-passive availability model, both provided by the IBM Systems Director.

Backup and Restore

SDMC provides the capability to back up the entire virtual machine to removable media or to a remote
File Transfer Protocol (FTP) server. You can restore using the backup file from the removable media or
from a remote FTP server. The restore operation is a full image deployment and all existing files are
replaced from the backup file. Unlike the HMC, SDMC backs up the entire disk instead of individual
files.

For more information about performing a backup and restore of the SDMC environment, see Backing up
and restoring the SDMC

Additional functions

The SDMC includes the IBM Systems Director base management functions which offers you additional
capabilities to manage your heterogeneous and large homogeneous infrastructure better. These
capabilities include:
v Automation manager
v Update manager
v Status manager

SDMC supported and unsupported systems
Support for POWER processor-based systems with either software or hardware appliance depends on the
type of POWER system you have. This topic provides a complete listing of which appliance is supported
with which system.

Table 32. POWER7 support by SDMC

POWER7 models Machine types SDMC

795 9119-FHB Hardware appliance only

780 9179-MHB Hardware appliance only

770 9117-MMB Hardware appliance only

755 8236-E8C Hardware or software appliance

750 8233-E8B Hardware or software appliance

720 8202-E4B Hardware or software appliance

740 8205-E6B Hardware or software appliance

710/730 8231-E2B Hardware or software appliance

PS701 8406-71Y Hardware or software appliance

PS700 8406-70Y Hardware or software appliance

Table 33. POWER6 support by SDMC

POWER6 Models Machine types SDMC

595 9119-FHA Hardware appliance only

575 9125-F2A Hardware appliance only

570 9117-MMA Hardware appliance only

570 9406-MMA Hardware appliance only

560 8234-EMA Hardware appliance only
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Table 33. POWER6 support by SDMC (continued)

POWER6 Models Machine types SDMC

550 8204-E8A Hardware or software appliance

550 9409-M50 Hardware or software appliance

520 8203-E4A Hardware or software appliance

520-SB (IBM Smart Cube) 8261-E4S Hardware or software appliance

520 9408-M25 Hardware or software appliance

520 9407-M15 Hardware or software appliance

JS23/43 7778-23X Hardware or software appliance

JS22 7998-61X Hardware or software appliance

JS12 7998-60X Hardware or software appliance

Supported configurations
You can connect your SDMC to host systems in a variety of ways.

The following topic describes the different ways you can manage host systems using the SDMC.

Figure 1. SDMC managing multiple Power Systems servers

Figure 2. SDMC managing two different Power systems, where one is managed by an HMC
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SDMC redundancy and high availability features
Implementing SDMC in a high availability (HA) or a redundant setup can provide improved
serviceability to the SDMC appliance and provides backup to the system in case of a disaster.

SDMC HA versus redundant setup

If you are familiar with redundant HMC setup in your Power Systems environment, you can do the same
with SDMC, because multiple SDMCs can connect to and actively manage a single host.

For more information about the tasks associated with SDMC redundancy and high availability, see SDMC
installation and configuration scenarios and Configuring high availability.

You can also implement SDMC HA, which provides active/passive failover capability, with one active
SDMC and one passive SDMC on standby to take over in case of failure.

In addition to providing the management capabilities currently in the HMC for the managed Power
Systems hosts, the SDMC also can manage the operating systems of the hosts themselves by connecting
to the Common Agent Services (CAS) agent on the managed systems through an agent manager.
However, the CAS agent has the limitation of only a single connection to an agent manager and is not
capable of a redundant connection. Therefore, the SDMC HA feature is provided to eliminate this
limitation as a single point of failure if you require high availability for this functionality.

The choice between a redundant setup versus an active/passive HA implementation depends on your
planned usage of the SDMC:
v In an environment where the SDMC is being used for HMC-like management functions, the redundant

setup provides the most availability and is the easiest to set up and administrate. Both SDMCs will be
active and can continue to provide functions for the managed systems should one of them have a
failure. The setup of a redundant SDMC environment only involves adding the managed system to
both SDMCs.

Figure 3. HMC and SDMC managing the same server at the same time

Figure 4. Two SDMCs managing the same server at the same time
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v For an environment where the SDMC is being used for agent OS management and there is a high
availability requirement for that function, SDMC HA is needed. If your active SDMC fails, the passive
standby SDMC automatically takes over and management functions for the managed systems are
restored in about 10 minutes. Some extra planning, setup, and administrative steps are required to
implement SDMC HA. For more information about the planning tasks associated with implementing
high availability, see Planning for high availability, redundancy, and failover.

The following table shows the differences between redundant HMCs and IBM Systems Director high
availability setup.

Table 34. Differences between a redundant and a replication HA environment

HMC SDMC with redundancy
Systems Director or SDMC
with HA

Type of environment Redundant Redundant Replication

High availability topology Active/active: Both
consoles are active at the
same time.

Active/active: Both
consoles are active at the
same time.

Active/passive: Only one
console is active at a time.

Data Data is not identical. Data is not identical. All data is identical on the
two nodes.

Management console HMC Systems Director Systems Director

Console versions Can be different Can be different Must be the same

In a redundant setup, it is also possible to have one SDMC point to another SDMC's agent manager,
which would allow both SDMCs to manage the agents at the same time. However, since the agent
manager is running on only one of the SDMCs, this setup is a single point of failure. If this SDMC goes
down, the other SDMC loses contact with the agents.

Active/passive HA overview

In a high availability environment, two SDMCs operate as synchronized nodes in an active/passive
cluster. One node in the environment is kept active at all times, and a second passive node is kept in
close synchronization. If your active node fails, the passive node (on standby, waiting for a failure of the
active node) takes over in about 10 minutes.

The internal software components that make up SDMC HA are transparent to you and do not need to be
directly configured. Floating IP addresses used to connect to the active SDMC can be moved between the
nodes, by using the active node. The OS on the passive node is started, but the software stack is not.

Running the Guided Setup wizard or the command-line interface commands on the SDMC that is
designated to be the primary node configures the internal HA components on both the primary and
secondary SDMCs.

High availability terminology

Refer to this list of terms to help you better understand high availability concepts:

Node A node is an SDMC that is configured to be part of a high availability environment.

Active node
An active node manages your environment. Only one node is active at a time.

Passive node
The passive node is not currently active. Any changes you make to the active node are replicated
to the passive node.
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Primary node
This is the node you use to set up high availability. It is initially the active node. When you set
up a high availability cluster, the IBM Systems Director data, remote authentication configuration
settings, users, and firewall settings on this node are replicated to the secondary node.

Secondary node
This is the node that you set up to take over if the primary node fails. It is initially the passive
node, but takes over as the active node if the primary node is detected to have failed.

Network status IP address
The cluster nodes use this IP address to determine which node is connected to the network. If
they cannot contact each other, the node that can connect to this IP address becomes the active
node.

Floating IP address
This address is always assigned to the active node. Always access this address so that you do not
have to know which node is active. It also enables you to use IBM Systems Director Common
Agent with high availability.

Active/passive HA mirrored directories

The following directories that are replicated and synchronized between the active SDMC and the passive
SDMC in the HA cluster.

Table 35. Replicated and synchronized SDMC directories

Directory Description

/opt/ibm/director/data Director data

/home/db2inst1 DB2 data

/opt/ibm/director/keys License keys

/opt/ibm/director/lwi/conf/overrides Director property overrides

/opt/ibm/director/lwi/runtime/agentmanager/eclipse/
plugins/com.ibm.tivo li.cas.manager/config

CAS agent manager config

/opt/ibm/director/lwi/runtime/agentmanager/eclipse/
plugins/com.ibm.tivo li.cas.manager/certs

CAS agent manager certificates

/opt/ibm/director/lwi/runtime/core/DATABASE CAS agent manager database

/opt/ibm/director/lwi/runtime/agentmanager/toolkit/
certs

CAS agent manager toolkit certificates

/opt/ibm/director/lwi/runtime/agentmanager/toolkit/
config

CAS agent manager toolkit configuration files

/var/lib/dhcp Dynamic Host Configuration Protocol (DHCP) server

config /dump Flexible service processor (FSP) dump files

/var/hsc/log SDMC log files

/var/hsc/profiles Profile files

/opt/hsc/data/utilization Utilization files

SDMC HA synchronized data

The following data changes on the active SDMC are synchronized to the standby SDMC:
v User ID additions
v User ID modifications
v User ID deletions
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v Firewall changes
v Network Time Protocol (NTP) configuration
v Kerberos and Lightweight Directory Access Protocol (LDAP) configuration
v Initial HA configuration

– Distributed Replicated Block Device (DRBD) configuration
– Users
– Authentication files
– LDAP and Kerberos
– Firewall settings
– Domain Name System (DNS) resolver
– NTP configuration

SDMC HA processes monitored

The following processes are monitored by the SDMC HA for a redundant takeover:
v Director
v DB2
v DRBD
v CIM server
v HA MQ daemon – MQ server
v HA daemon – Processes MQ messages
v NTP server
v DHCP server

Active/passive HA: Log location

The locations of the HA log files follow:
v /opt/ibm/director/ha/logs/daemon0-x.log

Table 36. daemon0-x.log file description

Log file Description

daemon0-x.log HA daemon log

mq0-x.log ActiveMQ log

smha.log TSA monitor log

init0-x.log Initial configuration initiated from outside the Director
process

v /opt/ibm/director/lwi/logs
HA task logs captured in the Systems Director HA configuration task.

v The daemon log and mq log are rolling logs with up to five log files, where x is the log file number.
Each log file can contain approximately 10 MB of data.

SDMC and HMC command-line differences
There are differences between the HMC commands and the SDMC commands.

Commands used to manage the Power Systems servers such as lssyscfg, lshwres, and chhwres that are all
supported and virtually identical to the commands in the HMC. Any scripts that you may have that use
these commands should continue to work with no changes.
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To see all of the HMC commands that are supported on the SDMC, run the smcli lsbundle command.
The commands that have been carried over from the HMC are in the psm bundle.

The following topic describes how to run SDMC commands. Commands for managing Power Systems
resources can be run in exactly the same way as on an HMC. However, to integrate into the Systems
Director way of doing commands, there are additional ways to issue commands. The following
commands are all equivalent:
v lssyscfg –r sys

v smcli lssyscfg –r sys

v smcli psm lssyscfg –r sys

v The commands that have been carried over from the HMC are aliased. Therefore, you can run the
command in three ways from the command line: lssyscfg, smcli lssyscfg,, or smcli psm lssyscfg .

v Add managed system (mksysconn) in SDMC has been replaced by the smcli discover and smcli
accesssys Systems Director commands.

v Two attributes, primary_state and detailed_state, are introduced to the lssyscfg and lssysconn
commands to indicate the respective Systems Director state mapping. The state field is deprecated. It is
only shown when the -F option is used.

v Man pages for the SDMC commands can be displayed by running either man command_name or man
psm.command_name.

The following tables compare HMC command-line interface (CLI) function with SDMC CLI function.
These tables display only the changes, and all functions not shown can be assumed to be similar.

Table 37. Power Systems management commands

HMC tasks and commands SDMC commands Notes

Add Managed System: mksysconn –r
sys/frame

smcli discover –H smcli accesssys Discover and access are two separate
steps on SDMC. Make sure you
specify the IP or hostname in SDMC;
otherwise, by default, it discovers
everything on your subnet. If SDMC
is acting as the DHCP server, systems
must be automatically discovered.
You must request access.

Remove Managed System: rmsysconn
–o remove

smcli rmsys You can disconnect by using the
smcli revokeaccesssys command;
however, to completely remove the
system, you must use smcli rmsys.

List system or partition states:
lssyscfg –r sys/lpar –F state

lssyscfg –r sys/lpar –F
primary_state,detailed_state

Although the HMC state option is
supported, to view the states as the
SDMC GUI displays them, you need
to view the primary_state and
detailed_state.

List serviceable events: lssvcevents smcli lssvcproblem

Table 38. Appliance (SDMC) management commands

HMC tasks and commands SDMC commands Notes

List and change HMC information
such as version and locale: lshmc /
chhmc

lsconfig / chconfig

List and change HMC network
settings: lshmc –n / chhmc

lsnetcfg / chnetcfg
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Table 38. Appliance (SDMC) management commands (continued)

HMC tasks and commands SDMC commands Notes

Backup and restore console data:
bkconsdata

backup / restore Hardware appliance only

LDAP configuration: chhmcldap /
lshmcldap

cfgldap / lsldap

Shut down and restart HMC;
hmcshutdown

smshutdown

Create and list HMC users:
ls/mk/ch/rmhmcuser

mksmusr / chsmusr / rmsmusr /
smcli lsuser

Save and restore upgrade data:
saveupgdata / rstupgdata

N/A This is not needed on SDMC because
the save/restore process happens
automatically as part of an upgrade.

Manage password policies:
mk/ch/ls/rmpwdpolicy

N/A SDMC does not support password
policy profiles.

Manage access control:
mk/ch/ls/rmaccfg

smcli mk/ch/ls/rmrole

Monitor HMC: monhmc N/A

Systems Director Management Console limitations
Learn about IBM Systems Director Management Console (SDMC) limitations.

Consider the following limitations when you plan to migrate from Hardware Management Console
(HMC) to SDMC:
v Replication of user data, groups data, LDAP or Kerberos configuration data, and outbound

connectivity configuration data is not supported in SDMC.
v Management of POWER5™ technology-based systems is not supported in SDMC.
v Modem or VPN support for Call home function is not available in SDMC. The Call home function is

supported only on a network connection over SSL.
v Users cannot disconnect and reconnect to old sessions of SDMC.
v No Advanced Manager support in SDMC.
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Notices

This information was developed for products and services offered in the U.S.A.

The manufacturer may not offer the products, services, or features discussed in this document in other
countries. Consult the manufacturer's representative for information on the products and services
currently available in your area. Any reference to the manufacturer's product, program, or service is not
intended to state or imply that only that product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any intellectual property right of the
manufacturer may be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any product, program, or service.

The manufacturer may have patents or pending patent applications covering subject matter described in
this document. The furnishing of this document does not grant you any license to these patents. You can
send license inquiries, in writing, to the manufacturer.

For license inquiries regarding double-byte character set (DBCS) information, contact the Intellectual
Property Department in your country or send inquiries, in writing, to the manufacturer.

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: THIS INFORMATION IS PROVIDED “AS IS ” WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
The manufacturer may make improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.

Any references in this information to websites not owned by the manufacturer are provided for
convenience only and do not in any manner serve as an endorsement of those websites. The materials at
those websites are not part of the materials for this product and use of those websites is at your own risk.

The manufacturer may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact the
manufacturer.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement,
IBM License Agreement for Machine Code, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
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same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning products not produced by this manufacturer was obtained from the suppliers of
those products, their published announcements or other publicly available sources. This manufacturer has
not tested those products and cannot confirm the accuracy of performance, compatibility or any other
claims related to products not produced by this manufacturer. Questions on the capabilities of products
not produced by this manufacturer should be addressed to the suppliers of those products.

All statements regarding the manufacturer's future direction or intent are subject to change or withdrawal
without notice, and represent goals and objectives only.

The manufacturer's prices shown are the manufacturer's suggested retail prices, are current and are
subject to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to the manufacturer, for the purposes of developing, using, marketing or
distributing application programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not been thoroughly tested
under all conditions. The manufacturer, therefore, cannot guarantee or imply reliability, serviceability, or
function of these programs. The sample programs are provided "AS IS", without warranty of any kind.
The manufacturer shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. _enter the year or years_.

If you are viewing this information in softcopy, the photographs and color illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at
Copyright and trademark information at www.ibm.com/legal/copytrade.shtml.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Other product and service names might be trademarks of IBM or other companies.
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Terms and conditions
Permissions for the use of these publications is granted subject to the following terms and conditions.

Personal Use: You may reproduce these publications for your personal, noncommercial use provided that
all proprietary notices are preserved. You may not distribute, display or make derivative works of these
publications, or any portion thereof, without the express consent of the manufacturer.

Commercial Use: You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make derivative works of
these publications, or reproduce, distribute or display these publications or any portion thereof outside
your enterprise, without the express consent of the manufacturer.

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the publications or any information, data, software or other intellectual property
contained therein.

The manufacturer reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as determined by the manufacturer,
the above instructions are not being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.

THE MANUFACTURER MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THESE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED
WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR
PURPOSE.

Notices 35



36 Power Systems: Overview of SDMC


	Overview of SDMC
	Contents
	SDMC concepts
	Comparing HMC and SDMC features
	Comparing the HMC and SDMC
	How the SDMC is used
	Virtualization enhancements
	Terminology differences between HMC and SDMC
	Navigation differences between the HMC GUI and the SDMC GUI
	Comparing HMC tasks and SDMC tasks
	Server (host) tasks
	Partition (virtual server) tasks
	Frame (power unit) tasks
	HMC and SDMC management tasks
	Service management
	Functional differences between the HMC, IVM, and SDMC

	SDMC supported and unsupported systems
	Supported configurations
	SDMC redundancy and high availability features
	SDMC and HMC command-line differences
	Systems Director Management Console limitations

	Notices
	Trademarks
	Terms and conditions





